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1 User interface 
The user interface of your system software is divided in individual panes that can be 
shown or hidden as required. Additionally, you can move, minimize, and arrange the 
panes according to your needs. Thus, the user interface is variable and possibly 
structured differently. 

 
 
 

The following table describes the individual areas of the user interface: 

No.  Item Description 

1 Menu bar and toolbar Contains menu items and provides fast access to frequently 
used functions. 

2 Buttons of the views Contains buttons for accessing the different views (CAM, 
Camera and Processing) and the available tools. 

3 Pane Workflow setup Contains information on the tools, the scan fields, and other 
structures of the work file. 

4 Toolbar of the view Contains functions for displaying the objects. 

5 Views Two-dimensional view of the part that can be zoomed. 
Contains switchable views with different functions. 

6 Panes Navigation, 
Properties, and Camera 

Contains several panes with information on objects or on the 
current position. 

7 Panes Fault monitor and 
Messages 

Contains several panes with a list of errors and messages. 
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1.1 Pane Workflow setup 
The pane Workflow setup contains information on the currently loaded processing 
data such as layer, scan fields, used tools, etc.  

Most of the entries contain functions that can be activated via the context menu. 

 
 

The entries of the pane Workflow setup are described in the following table: 

Item Description 

Material composition In this field, the settings of the materials used can be 
adjusted. 

Layout Displays the existing layers and the imported files. 

Toolpaths Contains the toolpaths' settings for calculation. 

Scan fields Displays the existing scan fields. 

Processing Here, structures of production phases, work packages, 
tasks, and tool assignment are displayed. 

 

1.1.1 Material composition 
This section of the Workflow setup displays the existing layers according to the 
material surface. 

 
 

The entries of the context menu are described in the following table: 

Section/Item Name Description 

Material 
composition 

Change number of layers Here, the number of layers can be 
adapted. 

Layer Delete Delete selected objects 
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1.1.2 Layout 
This section of the Workflow setup contains information on the different layers of the 
processing data and the contained objects. 

 
 

The entries of the section Layout are described in the following table: 

Item Description 

Layers Contains all existing layers. 

Imported files Name and path of the imported files. 
 

Via this context menu, specific functions of the individual items can be activated. The 
menu is opened with a right-click on the section or item. 

The entries of the context menu are described in the following table: 

Section/item Name Description 

Layout Import old version Imports CBF files that have been created 
with a former version of the application. 

Layout Import... Opens a dialog for importing files. The 
existing data remain. 

Layout Reimport all Reimports previously imported data. 

Layout Export... Exports data to a foreign format. 

Layers Add layer Adds a new layer. 
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Section/item Name Description 

Layers Show/Hide empty layers Empty layers (with 0 elements) are 
shown/hidden. 

Layers Export... Exports data to a foreign format. 

Selected layer Select by layer Marks all objects of the selected layer. 

Selected layer Color... Changes the color of the objects within a 
layer in the view CAM. 

Selected layer Visible Shows/Hides the layer in the view CAM. 

Selected layer Selectable Disables/Enables editing objects within 
the selected layer. 

Selected layer PCB layer Assigns the layer to a PCB layer. 

Selected layer Display mode Sets how the objects are displayed in the 
view CAM. 

Selected layer Technology Assigns a technology to the layer. The 
selected technology determines which 
tools can be used. 

Selected layer Inverse Structures the source layer from the 
inside. Example: In a letter or a number 
the inner area is structured. 

Selected layer Export... Exports data to a foreign format. 

Imported files Reimport all Reimports previously imported data. 

Imported files Export... Exports data to a foreign format. 

Selected imported 
file 

Reimport The selected group is reimported. 

Selected imported 
file 

Export... Exports data to a foreign format. 

Aperture  
(only visible if 
aperture is existing) 

Modify aperture... Opens the aperture view for editing the 
aperture. 

Aperture  
(only visible if 
aperture is existing) 

Select by aperture Marks all objects that use this aperture. 

Aperture  
(only visible if 
aperture is existing) 

Export... Exports data to a foreign format. 
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1.1.3 Toolpaths 
This section contains the toolpaths' settings for calculation. 

 
 

The entries of the section Toolpaths are described in the following table: 

Name Description 

Algorithm parameters (e.g. Fiducial, 
Top Layer, DrillPlated, etc.) 

The algorithm parameters contain various toolpath types. 

 

Via the context menu, specific functions of the individual items can be activated. The 
menu is opened with a right-click on the section or item. 

The entries of the context menu are described in the following table: 

Section/Item Name Description 

Toolpaths Compute all... All toolpaths are computed. The 
message Computing results is displayed. 

Toolpaths Add laser insulate... Opens a dialog with various insulation 
methods. 

Toolpaths Laser contour routing... Opens a dialog with various contour 
routing methods. 

Toolpaths Add conversion... Opens a dialog that enables you to 
create tool paths and fiducials. 

Toolpaths Export Exports data to a foreign format. 

Algorithm 
parameter 

Compute The toolpaths of the selected item are 
computed.  

Algorithm 
parameter 

Configure Opens a dialog to configure the 
algorithm parameters. 

Algorithm 
parameter 

Export Exports data to a foreign format. 

Toolpath type Set layer Here, a layer can be assigned to the 
toolpath type. The current layer is check-
marked. 

Toolpath type Export... Exports data to a foreign format. 
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1.1.4 Scan fields 
This section of the Workflow setup displays the existing scan fields. 

 
 

The entries of the section Scan fields are described in the following table: 

Item Description 

Scan field Scan field name with consecutive numbering. 
 

Via this context menu, specific functions of the individual items can be activated. The 
menu is opened with a right-click on the section or item. 

The entries of the context menu are described in the following table: 

Section/item Name Description 

Scan fields Hide/Show scan fields The selected scan field is hidden or 
shown. 
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1.1.5 Processing 
This section of the Workflow setup contains the production phases. 

 
 

The entries of the area Processing are described in the following table: 

Item Description 

Settings (Standard) Contains the work packages. 

PCB phase (e.g. Bottom Side, 
Top Side) 

Contains the production work packages of the respective 
PCB side. 

 

Via this context menu, specific functions of the individual items can be activated. The 
menu is opened with a right-click on the area or item. 

The entries of the context menu are described in the following table: 

Area/item Item Description 

Processing Add production phase Adds a new production phase 

Processing Export Exports data to a foreign format. 

Settings (Standard) Set phase ID Sets the phase ID to Undefined or 
Production. 

Settings (Standard) Set mirrored Determines whether the contents of the 
Settings (Standard) are mirrored or not 
mirrored. 

Settings (Standard) Add work package Adds a new work package to the 
Settings (Standard). 

Settings (Standard) Export Exports data to a foreign format. 

Work package Set WP ID Sets the ID of the work package.  

Work package Add task Adds a new task to the work package. 

Work package Export Exports data to a foreign format. 

PCB phase (e.g. 
Bottom Side, 
Top Side) 

Computing a toolpath Computes the toolpaths of the selected 
PCB phase. 

PCB phase (e.g. 
Bottom Side, 
Top Side) 

Computing scan fields Computes the scan fields of the selected 
PCB phase. 

PCB phase (e.g. 
Bottom Side, 
Top Side) 

Hide scan fields Show/Hide the scan fields of the 
selected PCB phase. 

PCB phase (e.g. 
Bottom Side, 
Top Side) 

Set phase ID Sets the phase ID to Undefined or 
Production. 
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Area/item Item Description 

PCB phase (e.g. 
Bottom Side, 
Top Side) 

Set mirrored Determines whether the contents of the 
PCB phase are mirrored or not mirrored. 

PCB phase (e.g. 
Bottom Side, 
Top Side) 

Change sorting Here, the sorting of the PCB phase can 
be changed. Standard (from the right 
upper side to the lower left side) or LPKF 
ProtoLaser optimized. 

PCB phase (e.g. 
Bottom Side, 
Top Side) 

Add work package Adds a new work package to the 
selected PCB phase. 

PCB phase (e.g. 
Bottom Side, 
Top Side) 

Export Exports data to a foreign format. 

Work package (e.g. 
Drilling, Structure) 

Computing scan fields Computes the scan fields of the selected 
work package. 

Work package (e.g. 
Drilling, Structure) 

Hide scan fields Show/Hide the scan fields of the 
selected work package. 

Work package (e.g. 
Drilling, Structure) 

Set WP ID Sets the ID of the work package.  

Work package (e.g. 
Drilling, Structure) 

Add task Adds a new task to the selected work 
package. 

Work package (e.g. 
Drilling, Structure) 

Export Exports data to a foreign format. 

Task Assign tool Assign the tool to the task. 

Task Export Exports data to a foreign format. 
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1.2 Pane Layers 
The pane Layers lists the layers. Depending on the template you selected at the 
beginning of the project, the number and types of the layers vary. 

 
 

 

The icons/functions are described in the following table: 

Icon Name Description 

 

New layer Adds a new layer. 

 

Delete layer Deletes a selected layer. 

 Order by z Sorting function: Sorts the layers according to their display 
priority in z direction. 

 

Move layer up Moves up a selected layer by one position. 

 

Move layer down Moves down a selected layer by one position. 

 Hide empty Shows/Hides layers without content. 
 

The entries of the pane Layers are described in the following table: Most of the 
settings can also be set in the context menus of the pane Workflow setup. 

Name Description 

[Z] Sorting function: Sorts the layers according to their 
display priority in z direction. 

Color In this column, a color is assigned to each layer. The 
layers in the view CAM correspond to the selected color 
in the respective column of the layer. 

Vis (Visible) Shows/Hides the respective layer in the view CAM . 

Sel (Selectable) Activate this function to make the layer selectable with the 
mouse in the view CAM. 

Layer Indicates the name of the layer. 
The following brackets contain the number of objects that 
are on the respective layer. 

PCB layer You can set the PCB layers in the drop-down list. 
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Name Description 

Mode In this drop-down list you can determine which display 
mode is to be used for the respective layer. 

Tech (Technology) In this column, a technology is assigned to each layer. 

Inv. (Inverse) Structures the source layer from the inside. 
Example: In a letter or a number the inner area is 
structured. 

 

1.3 Pane Properties 
The pane Properties contains information on the loaded processing data. Depending 
on the selected entry in the pane Workflow setup, different information is displayed.  

 
 

 

1.4 Pane Camera 
The pane Camera displays the camera view of the object to be processed. 
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1.5 Pane Navigation 
The pane Navigation displays the object to be processed in small format. The zoomed 
area in the view CAM is marked in the pane Navigation (1). By keeping the left mouse 
key pressed, the marked area can be moved. 

 
 

1.6 Pane Fault monitor 
The pane Fault monitor contains a list of all faults. These can refer for example to 
error messages during part production or to a problem while starting the system. 

 
 

The icons/functions are described in the following table: 

Icon Name Description 

 

Accept all All errors not yet acknowledged are acknowledged 
automatically. 

 

Clear all All errors already acknowledged are deleted from the list. 

 

The entries of the pane Fault monitor are described in the following table: 

Description Description 

Fault Time Displays the time and date when the error occurred. 

Fault description Detailed description of the error that occurred. 

Accept time Time when the error was acknowledged. 

Fault Code Error code 
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1.7 Pane Messages 
The pane Messages contains a list of all system messages. These are divided into 
Errors, Warnings, Messages, and Service messages. 

 
 

 

The sections of the pane Messages are described in the following table: 

Item Description 

Errors Errors are critical system software errors. The errors can 
be displayed or hidden by clicking on Errors. 

Warnings Warnings are due to input errors that the user has 
caused. For example, these can be information on 
canceled actions or actions that have not been executed 
properly and that can cause a restricted program 
operation. 
The warnings can be displayed or hidden by clicking on 
Warnings. 

Messages Messages present statistical information of the system 
software. These can be feedback of the system software 
on certain actions that have been executed. 
For example: New document created 
The messages can be displayed or hidden by clicking on 
Messages. 

Service messages Service messages are displayed when maintenance of 
the system is due. Contact the LPKF Service. The service 
messages can be displayed or hidden by clicking on 
Service messages. 
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1.8 Toolbar View 
The toolbar View is a vertical bar that is available for all views. Depending on the view, 
the available functions can vary. 

The toolbar View contains the following icons/functions: 

Icon Item Description 

 
Selection 

By dragging the mouse a rectangular area is selected. All 
objects inside are marked. 

 
Pan 

The view is moved around the mouse. Can also be 
activated by pressing the mouse wheel (if available). 

 
Zoom area 

The selected area is zoomed in. 

 
Fit all 

Displays the entire layout. In the view Processing the 
entire processing area is displayed. 

 

Polygonal 
selection 

Enables a selection of objects by drawing a polygon. 

 
Display grid 

The grid is shown/hidden. 

 
Snap to grid 

If active, actions can only be executed on grid points. 
Also working if the grid is hidden. 

 
Snap to object 

If active, the mouse cursor can be snapped to specified 
points on an object. 

 Snap to angle 

If active, the mouse cursor can be snapped to a specific 
angle when a second point is selected (not available for 
every function). 
In the options you can define additional angles in Snap. 

 

In the view Apertures the following functions are available: 

Icon Item Description 

 

Save current 
aperture 

Saves the current aperture. If a new aperture is created, a 
name has still to be entered. 

 

Save current 
aperture under a 
new name 

Saves the current aperture under a new name. 

 

Close aperture 
view 

Closes the aperture view. If the aperture has been edited 
it can still be saved. 

 

In the view Camera the following functions are available: 

Icon Item Description 

 
Crosshair overlay 

Shows the crosshair in the camera view. 

 

Crosshair overlay 
with circle 

Shows the crosshair with circle in the camera view. 

 

Crosshair overlay 
with rectangle 

Shows the crosshair with rectangle in the camera view. 
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1.9 Views 
In the different views, the processing data are created, edited, and produced. It is 
possible to switch between the different views at any time. 

Most of the functions that are available and applicable are displayed in the upper 
toolbar.  

 
 

The views are explained in the following table:  

Item Description 

CAM View for editing the processing data. Here, objects can be 
created and edited. Imported data are displayed. 

Camera Here, the camera image is displayed.  

Processing In the view Processing the entire processing area with the 
production data is displayed.  

Aperture View for creating and editing apertures in order to use 
them as flashes in the CAM view. The same functions as 
in the view CAM are available. 
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1.9.1 CAM 
In the view CAM existing or imported data can be edited and new objects can be 
created. 

Icons with a small triangle (see following figure) have a context menu that can be 
opened by keeping the left mouse button pressed. It contains additional related 
functions. 

 
The icons/functions of the toolbar are described in the following table: 

Icon Item Description 

 
Selected layer 

Displays the currently selected layer. Left-click to open 
the drop-down list and change the layer by selecting 
another one. 

 Aperture 
selection 

Displays the currently selected aperture. Left-click to 
open the drop-down list and change the aperture by 
selecting another one. 

 
Flash 

Creates a flash based on the aperture currently selected. 

 
Path 

Creates a path in the current layer. 

 
Polygon 

Creates a polygon in the current layer. 

 
Rectangle 

Creates a filled rectangle in the current layer. 

 
Rectangle path 

Creates a rectangle path in the current layer. 

 
Circle by radius 

Creates a filled circle by defining a radius. 

 
Circle by points 

Creates a filled circle by setting three points. 

 
Circle path by 
radius 

Creates a circle path by defining a radius. 

 
Circle path by 
points 

Creates a circle path by setting three points. 

 
Text 

Creates a text. 

 
Rotate 

Rotates one or multiple objects around a definable pivot 
point. 

 
Move object 

Moves the marked object by a defined distance and 
direction. 
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Icon Item Description 

 
Mirror horizontal 

Mirrors one or multiple objects around the horizontal 
coordinate axis (x axis). 

 
Mirror vertical 

Mirrors one or multiple objects around the vertical axis of 
reflection (y axis). 

 
Scale 

Scales up or scales down the marked object by the scale 
factor. 

 
Expand 

Increases or decreases the marked object by a definable 
length. 

 
Round 

Rounds the corners of the marked object. 

 
Chamfer 

Chamfers the corners of the marked object. 

 
Merge 

Merges adjoining or overlapping objects to a single 
geometrical object. 

 
Difference 

Removes the area of a geometrical object that is 
overlapped by a second selected object. 

 
Split 

Splits a marked object by using a predefined path. 

 
Add point 

Adds a point on a marked line. 

 
Add mirror point 

Adds two points with the same distance from the 
reference point. 

 
Move point 

Moves a marked point. 

 
Split path 

Splits the marked line segment of a path 

 

Convert to 
polygon 

Fills a marked closed path. 

 

Convert to closed 
path 

Removes the filling of filled objects. 

 
Group 

Groups marked objects. 

 
Ungroup 

Ungroups grouped objects. 
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1.9.2 Camera 
In the view Camera , the camera image is displayed. The camera image can be 
moved by manually entered values or via double-click. 

The icons/functions of the toolbar are described in the following table: 

Icon Item Description 

 

Measure point to 
point  

Measurement of the distance between two points. 

 
Measure point to 
line  

Measurement of the distance between a line and a 
point. First, the line is defined by two points and then 
the point is positioned. 

 

Measure circle by 3 
points  

Measure circle The circle is measured by three points 
that are selected on the circle. 

 
Fiducial search  

The fiducials are searched in the current camera image. 

 
Extraction system 
turn on/off 

Switch on/off the extraction system. Switching on the 
extraction system produces a vacuum that fastens the 
material. 

 
Activate pilot laser 

Activates/Deactivates the pilot laser 

 

Tab Navigation 

Using the functions of the tab Navigation  the processing point can be manually 
moved in the directions x, y, and z. 

By clicking on the following buttons the processing point is moved in x and y direction. 
The point moves by the entered step width which can also be adjusted. 

 
 
 

 

Use the button [AF] to activate the autofocus that automatically tries to focus the 
image. Additionally, you can move the position in z direction by using the up or down 
buttons. 

 
 
 
 

By using the button  the processing point can be moved to the position 
indicated in the fields x, y, and z. The current zero point is used as reference point (0, 
0, 0). 
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1.9.3 Processing 
In the view Processing the generated toolpaths are displayed on the material. 

The icons/functions of the toolbar are described in the following table: 

Icon Item Description 

 
Material settings 

In the dialog Material settings, several parameters of 
the material to be processed can be set. 

 
Tool library 

In this dialog, tool parameters can be modified. 
Custom tools can also be created. 

 
Process all 

Starts processing of all toolpaths and work packages. 

 
Stop processing 

The current processing procedure is stopped. 

 

Pilot laser 
turn on/off 

Turn pilot laser on/off. 

 
Activate laser 

Starts the warm-up phase of the laser and opens the 
laser shutter. 

 
Extraction system 
turn on/off 

Switch on/off the extraction system. Switching on the 
extraction system produces a vacuum that fastens the 
material. 

 
Loading position 

The x/y table moves to the loading position. 

 

Tab Navigation 

Using the functions of the tab Navigation  the processing point can be manually 
moved in the directions x, y, and z. 

By clicking on the following buttons the processing point is moved in x and y direction. 
The point moves by the entered step width which can also be adjusted. 
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By clicking on the following buttons the processing point is moved in z direction. 

 
 
 

Using the button  the processing point can be moved to the position indicated in 
the fields x, y, and z. The current zero point is used as reference point (0, 0, 0). 
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2 Menus 

2.1 Menu File 
This menu contains the standard functions of the application. 

 
 

The entries of the menu File are described in the following table: 

Icon Item Description 

 
New... 

Starts a new project from a selected template or opens a 
project that is already existing (file extension *.cp2d or 
*.cbf). 

 
Open... 

Opens an existing project file (file extensions *.cbf and 
*.cp2d). 

 Recent files Displays the five files that have been opened/edited 
recently. 

 
Save 

Saves the currently edited project file containing all 
changes with the same name and storage location. 

 
Save as... 

Saves the currently edited project file containing all 
changes with a different name and/or storage location. 



 

 

Menus 
 

CircuitPro 3.0 PL 

28/112  LPKF Laser & Electronics AG | V. 1.0 

Icon Item Description 

 
Import... 

Imports CAD files of various formats. 

 Reimport Provides the possibility to reimport the data previously 
imported or to edit the files before the import. 

 Export Exports the current project. 

 Import old version... Imports *.cbf files that have been created with a former 
version of the application. 

 Recent files Displays the last five files that have been opened/edited 
recently. 

 
Print... 

Prints the current layout. Use the diverse settings to 
optimize your print result. 

 
Print preview... 

Displays the preview of the print results using the current 
print settings. 

 Info Contains information on software and hardware. 

 Help... Displays the detailed help. 

 Options... Contains application settings, such as language settings. 

 
Exit 

Exits and closes the current application. 

 

2.1.1 New 
Starts a new project from a selected template or opens a project that is already 
existing (file extension *.cp2d or *.cbf). 

Summary 

The command New enables you to create a new project file based on an existing, 
installed template or to search on your computer for a custom template that is suitable. 
The tab Projects lists the recently edited projects. 

2.1.2 Open 
Opens an existing project file (file extensions *.cp2d and *.cbf). 

Summary 

In the dialog to be displayed, navigate to the desired file and click on Open. The data 
are displayed in the CAM view. 

2.1.3 Recent files 
Displays the files that have been recently opened/edited. 

2.1.4 Save 
Saves the currently edited project file containing all changes with the same name and 
storage location. 

2.1.5 Save as 
Saves the currently edited project file containing all changes with a different name 
and/or storage location. 
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2.1.6 Import 
Imports CAD files of various formats. 

Summary 

The following formats are supported: 

Format Description Extension 

CAM Data format of the system *.cam 

Excellon Data format for drilling and milling 
operations on PCBs. 

*.drl; *.drd 

Gerber Data format for PCB image files *.gbr 

Gerber X,  
Gerber X2 

Extended data format for PCB image files *.gbx 

JOB files Data format for BoardMaster JOB files *.job 

LMD LPKF Mill Drill Data format for data transfer 
between LPKF software products 

*.lmd 

HPGL Data format for drawings, formerly used for 
operating pen plotters. 

*.plt 

DXF Data format for drawings created in 
AutoCAD 

*.dxf 

Sieb & Meyer Data format for drilling and milling 
operations on PCBs. 

*.drl 
*.sm1; *.sm2 

ODB++ Data format for the PCB layout, drill data, 
netlists, and component data. 

*.zip 

TIFF Data format for image data *.tiff; *.tif 
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The dialog is arranged as follows: 

 
 

The following information on the imported files are displayed: 

Column Description 

Import Activates/Deactivates the import of the file. 

File name Indicates the file name of the file to be imported. 

Format Displays the original format of the file to be imported. The 
selection can be changed. Click on the arrow to open the 
drop-down list. 

Aperture/Tool list Displays the assigned Aperture/Tool list. 
The selection can be changed. Click on the arrow to 
open the drop-down list. 

Layer/Template Displays the layer/template that is to be assigned in 
CircuitPro. 
The selection can be changed. Click on the arrow to 
open the drop-down list. 

Size/Format Displays the size/format of the layer. 

 

The dialog Import contains the following tabs: 

  



 
 

 

CircuitPro 3.0 PL 
 

Menus 

V. 1.0 | LPKF Laser & Electronics AG  31/112 

2D 

Displays the layout and the dimensions of the imported file: 

 
 
Apertures/Tools 

Displays the list of the apertures and the tools that you need for your imported project: 

 
 
The columns have the following meaning: 

Column Description 

Image Displays the shape of the aperture. 

Name Displays the name of the aperture. 

Mode 
Indicates if the aperture has been imported as a drawn object  or as a 

flash . 

Rotation Indicates if the aperture has been rotated (circular apertures are set to 0° 
by default). 

a-d Display parameters that describe the aperture size. Depending on the 
aperture shape, not all parameters are required. 
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Text 

Displays the ASCII text format of the imported file: 

 
 
Messages 

Displays the system messages of the current actions: 

 
 
The dialog Import contains the following sub tabs, depending on the tab you are 
currently using (2D, Apertures/Tools, Text or Messages): 
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General 

Displays the dimensions of the imported file: 

 
 
The following settings are available: 

Setting Description 

Size Displays the total size of the imported layout. 

Unit Displays the unit of measurement (millimeters or inches). 

Value Indicates if absolute values or relative values are used for calculating. 

Decimal Indicates if leading or trailing zeros are suppressed. 

Digits m.n Indicates the number of decimal places in the coordinates: 
m = integer digits 
n = decimal places 
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Options 

Provides various options: 

 
 
The following settings are available: 

Setting Description 

Use layer name Uses the layer names defined in the Gerber file. 

Use layer polarity Activates/Deactivates the layer polarity analysis during the Gerber 
import. 

Rotate Square Activates/Deactivates the automatic rotation of square objects 
during the Gerber import. 

Step and Repeat to flash Activates/Deactivates combining object collections to flashes for 
Step and Repeat commands within the file. 

Rotate AM-Octagon Always adjusts the octagon edges to the axes. 

Set 360° interpolation as 
default 

Activates by default a 360° interpolation for circles, regardless of 
the corresponding commands in the file. 

Apply to all Gerber files Applies the setting to all imported Gerber files. 
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Attributes 

Is only displayed when the tab Apertures/Tools is activated and indicates the 
properties of the apertures and the tools: 

 
 
The following settings are available: 

Attribute Description 

Type Indicates the aperture type. Changing the type is possible in the drop-down 
list. 

Rotation Indicates a rotation of the aperture. Manual changes are possible. 

a-d Displays parameters that describe the aperture size. Depending on the 
aperture shape, not all parameters are required. 
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 Importing CAD data 

1. Click on File > Import… 
2. Select the data for the import in the displayed dialog. 

 
 
3. Click on [Open]. 
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 According to your imported file, the following contents are displayed (in this case a 
Gerber file): 

 
 
4. Check the imported data. If necessary, assign the corresponding layers. 
5. Click on [OK]. 
 The CAD files are imported and placed on the layers. The layout is displayed in 

the CAM view. 

 The CAD data have been imported. 

2.1.7 Reimport 
Provides the possibility to reimport the data previously imported. 

Refer to Import on 29.  

2.1.8 Export 
Exports data to an *.LMD file. 

Summary 

The LMD file is used for data transfer between LPKF software products. 
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 Exporting the project 

1. Click on File > Export... 
2. The following dialog is displayed: 

 
 

 The phase file is attached automatically. The columns CircuitPro phase(s)/work 
package(s), Map to phase, and Map to tool name(s) are filled with the required 
information from the phase file. 

 

If the phase file is not attached automatically you can find it in the installation folder of 
CircuitMaster or BoardMaster. 

3. In the field Export to file enter a name for the LMD file and select a saving location. 
4. Click on [Export]. 

 The project has been exported. 

2.1.9 Import old version 
Imports *.cbf files that have been created with a former version (2.x) of the application. 

2.1.10 Recent files 
Displays the files that have been recently opened/edited. 
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2.1.11 Print 
Prints the current layout. Use the diverse settings to optimize your print result. 

Summary 

Click on [Print], to start the print process with the current settings. 

To change the print options, various tabs are available. 

Tab General 

Contains general settings for the print process (number of pages, page range, etc.). 

 
 

Select Printer 

Select in this group the printer that is to be used for executing the print job. Use the 
button [Properties], to change the settings for the printer. 

Page Range 

In this group, select the pages to be printed. As soon as you want to print more than 
one copy, the option Collate is activated. This setting ensures that a complete copy 
is printed, before the next copy is started to be printed. 

View 

Here, you can define which view is to be printed. 

Print area 

Define in this group if the current view, the entire layout, the marked areas, or all is 
to be printed. 
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Tab Page Setup 

Contains general settings for the page to be printed (paper size, orientation). 

 
 

Paper 

Select the paper size and the paper tray of the printer. 

Orientation 

Select the orientation of the paper (portrait, landscape). 

Margins 

Defines the size of the margins. 
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Tab Settings 

Contains settings for the layout of the image to be printed (scaling, mirroring etc.). 

 

 
The upper section provides the following options: 

 Enable colors: 
Activates the color printing. 

 Auto rotate: 
Adjusts the page orientation in accordance with the entered orientation set in 
the printing properties  

 Include file name in print output: 
Prints the file name of the project on each sheet. 

 Inverse: 
Causes a display inversion of the rubout area. I.e. the area that is removed 
during production (e.g. rubout area) is not printed. 

 Mirror Y: 
Mirrors the object to be printed along the y axis. 

Scaling 

This group provides the following options: 

 Best fit according paper size: 
Automatically adjusts the printout to the preselected paper size. 

 1:1 
Causes that the printout is printed in the actual size. There is no 
scaling/adjusting to the actual paper size. Large graphics can be spread across 
several sheets. Small graphics can be too small and may be unreadable in 
some circumstances. 

 Manual scaling: 
Scales the printout according to the entered value. 
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Page count 

In this group, you can define which view is to be printed. 

 One page (centered, cropped): 
Prints the graphic centered on one page. I.e. that possible enlarged graphics 
that are printed on several sheets are trimmed. 

 Page count according to scaling: 
Prints the pages exactly in accordance with the specified number of pages in 
the print preview. 

Tab Printer calibration 

Contains parameters (rectangle size, printed size etc.) for calibrating the printer. 

 
 

Parameters 

This group provides the following options: 

 Rectangle size: 
Defines the size of the calibration rectangle by entering values for x and y. 

 Printed size: 
Used for the entry of the actual printed rectangle size. 

 Correction factor: 
Automatically displays the difference between the Rectangle size and the 
entered size in the Printed size. 
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2.1.12 Print preview 
Displays a preview of the printed layout. 

Summary 

Use [Print area] to set which elements of the layout are to be printed. The following 
print areas can be selected: 

 All visible: Prints all objects on visible layers. 
 View: Prints the current display of the view CAM. 
 Full layout: Prints all existing objects without regard to their visibility. 
 Selection: Only prints the selected objects. 

2.1.13 Info 
Contains information on software and hardware. 

Software 

Displays the version numbers and copyright of the program component. 

Hardware 

Displays information about the PC running the application. 

2.1.14 Help 
Displays the detailed help. 
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2.1.15 Options 
Contains application settings, such as language settings. 

General 

 
 

The options of the section General are described in the following table: 

Setting Description 

Application  

User level Selection between Advanced user and 
Service. 

Language Sets the language of the application interface. 

Units Units used in the application. 

Decimal separator Selection between dot (.) and comma (,). 

Undo/Redo 

Undo/Redo level Number of the maximum undo and redo 
actions. 

User and license information 

User name User name in the current application session. 

Organization User organization of the current application 
runtime license. 

Location Organization location of the current application 
runtime license. 

License key Customized license key for using this 
application. 

Auto save 

Time interval (min) Sets the time until a document is saved 
automatically. 

Auto save mode Switches on/off the auto save mode 
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Display 

 
 

The options of the section Display are described in the following table: 
 

Setting Description 

2D CAM view 

Background color Sets the background color of the view CAM. 

Pan and zoom rectangle color Sets the color of the rectangle of the visible 
area in the navigation view. 

Local selection color Sets the color for locally selected elements. 

Local selection feedback color This color serves as visual feedback while the 
mouse is moved over the selected control 
point. This ensures that the control point is 
changed with the next click. 

Global selection color Sets the color for globally selected elements. 

Preview color Sets the preview color. 

Optional lines color Sets the color of optional lines. 

Sketching elements color Sets the color for freely drawn elements. 

Show page outlines Displays how the area to be printed is divided 
into several pages. 

3D view 

Background color Sets the background color for the 3D view. 

2D Machining view 

Background color Sets the background color for the view 
Production. 

Show material Activates/deactivates the display of the 
material area, of the maximum processing 
area, and of the tool magazine. 

Max processing area color Sets the display color of the maximum 
processing area. 

Max processing area line style Sets the line style for the border of the 
maximum processing area. 

Camera area color Sets the color of the camera area. 

Camera area line style Sets the line style for the border of the camera 
area. 
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Setting Description 

Working area color Sets the color of the working area. 

Working area line style Sets the line style for the border of the working 
area. 

Material area color Sets the color of the material area. 

Material area line style Sets the line style for the border of the 
material area. 

Placement rectangle color Sets the color for the rectangle of the 
production data during the placement 
operation. 

Cursor 

Cross cursor full screen Switches on/off the full-screen mode of the 
cross cursor. 

Cross cursor size Sets the size of the cross cursor. 

Cross cursor width Sets the width of the cross cursor lines. 

Zoom cursor delay Sets the delay after which the zoom cursor 
disappears. 

Common 

Dynamic highlighting Sets the display behavior of objects under the 
mouse cursor in graphic views. 
Options: Off, Always, Only when Shift key is 
pressed. 

Show jumps in toolpath Activate/Deactivate display of jumps between 
toolpath lines 

Performance and quality settings Options: High performance, Performance, 
Quality, High quality 

Tooltip delay time Time before the tooltip is displayed [ms]. 

Tooltip display time Time how long the tooltip is displayed [ms]. 

Tooltip expand delay Time how long the tooltip is displayed with 
short information, before it expands and 
displays detailed information [ms]. 

Dynamic tooltip offset Offset for the dynamic tooltips from the current 
mouse position. 

Additive selection Activates/Deactivates an additive selection 
workflow. 

Max number of displayed objects Maximum number of displayed objects under 
a tree node; 0 represents no limit. 

Text 

Font Default font 

Size Default font size 

Alignment Text alignment 

Edit text color Text color during editing. 

Edit text box background color Text box background color during editing. 

Edit text box margins [pixels] Edit the margin between text and text box 
border. 

Edit text box border width [pixels] Edit text box border width. 
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Setting Description 

Edit text box border color Edit text box border color. 

Text position cursor margin Positioning the cursor margins of the font 
height in percent. 

 

Grid 

 
 

The options of the section Grid are described in the following table: 
 

Setting Description 

Grid 

Show Grid Activates/Deactivates the grid in the view. 

Grid spacing along X Sets the grid spacing in x direction. 

Grid spacing along Y Sets the grid spacing in y direction. 

Number of minor lines between major lines Sets the number of minor lines between major 
lines. 

Color of minor lines Sets the color of the minor lines. 

Color of major lines Sets the color of the major lines. 

Transparency of minor lines Sets the transparency of the minor lines. 

Transparency of major lines Sets the transparency of the major lines. 

Scale ruler 

Show scale ruler Activates/Deactivates the scale ruler in the 
view. 

Color Sets the color of the scale ruler. 
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Snap 

 
 

The options of the section Snap are described in the following table: 
 

Setting Description 

Snap to angle 

Available Activate/Deactivate snap to angle. 

Activate angles to snap Options: 5°, 10°, 15°, 22.5°, 30°, 45°, 90° 

Available angles to snap Makes it possible to create user-defined 
angles to snap. 

Relative angles to snap Activate/Deactivate snap to relative angle. 

Snap line color Sets the color of the snap lines. 

Snap to grid 

Available Activate/Deactivate snap to grid. 

Snap tolerance along X Indicates the minimum percentage in front of 
the snap interval in x direction for the snap 
function to be activated. At 100%, shifting from 
one to the next snap interval is activated. 

Snap tolerance along Y Indicates the minimum percentage in front of 
the snap interval in y direction for the snap 
function to be activated. At 100%, shifting from 
one to the next snap interval is activated. 

Activate snap to intervals Activate/Deactivate snap to intervals. 

Snap to intervals x Determines that two points always have this 
distance while editing. If the snap to tolerance 
value is set to 100%, the mouse cursor moves 
by this value.  

Snap to intervals y Determines that two points always have this 
distance while editing. If the snap to tolerance 
value is set to 100%, the mouse cursor moves 
by this value. 

Snap to object 

Available Activate/Deactivate snap to object. 

Snap to object tolerance [pixels] Is the tolerance within which objects can be 
snapped, in pixels. 

Snap to segment points Determines if snapping to a segment end 
point is executed when drawing an object. 
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Setting Description 

Snap to middle points of segment Determines if snapping to a segment center 
point is executed when drawing an object. 

Snap to center of circles and arcs Determines if snapping to a circle center is 
executed when drawing an object. 

Snap to lines intersection Determines if snapping to the intersection of 
two lines is executed when drawing an object. 

Snap to circle edge Determines if snapping to a circle edge is 
executed when drawing an object. 

Snap to object center Determines if snapping to the center of any 
object is executed when drawing an object. 

Snap to segment Determines if snapping to the segment is 
executed when drawing an object. 

Color of snapping marker Sets the color of the snapping marker. 

Color of snap target element Color that is used to highlight the object that is 
snapped to. 

Import/Export 

 
 

The options of the section Import/Export are described in the following table: 
 

Setting Description 

Preview 

New layer's color Preview color for objects assigned to the new 
layer. 

Import 

Compact data If set to True, geometrical objects that are 
composed of a lot of smaller objects are 
replaced with a single polygon that fills the 
same area. 

Reduce number of elements If set to True, the number of elements for 
open/closed paths and polygons is reduced. 

Watch changes 

Time interval (min) Sets the time interval to check for source file 
changes. 

Watch mode Activate/Deactivate watch mode. 
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Import assignments 

 
 

The options of the section Import assignments are described in the following table: 
 

Setting Description 

Aperture templates Selects the path to an existing aperture 
templates file. 

Import assignments Selects the path to an existing assignments 
file. Additionally, you can assign a new XML 
file by entering a new file name. 

Assignments 

File name File extension for assignment 

Format Assign the format for the import. 

Layer/Template Select the target layer for the import. 

Aperture/Tool list Select Aperture /Tool list. 

 

  



 
 

 

CircuitPro 3.0 PL 
 

Menus 

V. 1.0 | LPKF Laser & Electronics AG  51/112 

Export configurations 

 
 

The options of the section Export configurations are described in the following table: 
 

Setting Description 

Configurations file Indicates the path to the configuration file. 
The path can be selected/edited 
via the adjacent button 

Configurations Lists the existing configurations that are in the 
current configuration file. 
You can add or remove configurations by 
clicking on [Add] or [Remove]. 

Parameters 

File name Indicates the file name that is used for the file 
to be exported. 

Format Indicates the file format that is used for the file 
to be exported. 

Source objects Indicates the source objects that are to be 
exported in the file. 
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Gerber 

 
 

The options of the section Gerber are described in the following table: 
 

Setting Description 

Import 

Use layer polarity Activates/Deactivates analysis of layer polarity 
during Gerber import. 

Rotate square Activates/Deactivates automatic rotation of 
square objects during Gerber import. 

Step and repeat to flash Activates/Deactivates combining object 
collections to flash objects for step and repeat 
commands. 

Rotate AM octagon True always aligns the octagon borders to the 
axes. 

Use layer name Use layer name definition from Gerber file. 

360-degree interpolation as default Activates/Deactivates the 360-degree 
interpolation as default 
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Excellon 

 
 

The options of the section Excellon are described in the following table: 
 

Setting Description 

Import 

Fiducial diameter Sets the diameter of the fiducial during import. 

Pin hole diameter Sets the diameter of the pin hole. 
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LMD 

 
 

The options of the section LMD are described in the following table: 
 

Setting Description 

Tool conversion file Sets the path of the tool conversion file. 
Additionally, you can assign a new XML file by 
entering a new file name. 

Tool to be replaced Sets the tool to be replaced. 

Tool to be used Sets the tool to be used. 
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HPGL 

 
 

The options of the section HPGL are described in the following table: 
 

Setting Description 

Import 

Data type Defines how to import HPGL data, either as 
geometrical objects or as toolpaths. 

Plotter resolution Sets the plotter resolution used by the HPGL 
file. 

Resolution unit Defines resolution units (mm or inch). 
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DXF 

 
 

The options of the section DXF are described in the following table: 
 

Setting Description 

Import 

Default font The default font is used to replace fonts that 
are defined in a DXF file that are not installed 
on this PC. 
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STEP 

 
 

At the moment, there are no options for the STEP format. 

Miscellaneous 

 
 

The options of the section Miscellaneous are described in the following table: 
 

Setting Description 

Common 

Bounding box if number of objects greater Displays the bounding box if the number of 
objects to be moved exceeds this value. 

Replace original object Determines whether the source object is to be 
replaced by the newly created object. 

Keep second object Determines whether it is necessary to keep 
the tool object in operations 

Maximal printed pages Defines the maximum number of pages that 
can be printed. 

Message pop-up Sets types of messages that are displayed as 
pop-up message boxes (in addition to the 
entry in the Message View). 

Message pop-up w/o Message View Sets types of messages that are displayed as 
pop-up message boxes when the Message 
view is closed. 
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Setting Description 

Logging 

Verbose  If Verbose is set to True application diagnosis 
messages are displayed in the Message View 
as Service messages. 

Tool library 

Standard tool library file Location of the standard tool library file 
(ToolLibrary.xml), used for new projects. 

Save tool inside document True 
All settings of the tool library are saved in a 
separate file for the respective project. 
False 
All settings of the tool library are saved in the 
parent file ToolLibrary.xml and are available 
for each project. 

Toolpath generation 

Default tolerance Sets the default tolerance for toolpath 
generation algorithms. 

Extension of maximum strip length Defines the minimum allowed length of a strip. 
If a strip exceeds the maximum length and the 
remaining length is less than the given value, 
the strip will not be divided.  

Tolerances 

Curve combine Tolerance for combining selected geometrical 
objects. 

Accuracy for curve modifications Precision value used for curve modification 
operations. Decreasing the value improves the 
accuracy but increases the calculation time 
and memory consumption. This value affects 
all geometry operations such as Close path, 
Convert to path, Combine open paths, 
Convert to polygon, Convert to flash. 

Drag & Drop 

Delay time After mouse click, it is necessary to wait this 
time to move an object by dragging. 

Minimum distance [pixels] Dragging an object is not possible unless the 
mouse is moved for at least this distance. 

Maximum distance during delay time [pixels] Dragging an object is not started if the mouse 
is moved more than this distance during the 
set delay time. 
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Machine 

 
 

The options of the section Machine are described in the following table: 
 

Setting Description 

Scan fields 

Size x Sets the size of the scan field area in x 
direction. 

Size y Sets the size of the scan field area in y 
direction. 

Overlap x Sets the overlap of neighboring scan field 
areas in x direction. 

Overlap y Sets the overlap of neighboring scan field 
areas in y direction. 

Calibration grid pitch x Sets the spacing of the calibration grid 
covering the scan field in x direction. 

Calibration grid pitch y Sets the spacing of the calibration grid 
covering the scan field in y direction. 

Snap to calibration grid Defines whether the overlapped scan field 
areas share the common (overlapped) 
calibration grid points. 
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Logging 

 
 

The options of the section Logging are described in the following table: 
 

Setting Description 

Checking for updates 

Activate update checking Here, checking for updates on the LPKF 
homepage can be switched on/off. 

Update homepage LPKF homepage where the update 
information is stored. 

Login name Your login name to access the LPKF 
homepage. You have to sign in to get a 
password. 

Password Your login name to access the LPKF 
homepage. You have to sign in to get a 
password. 

Email settings 

Email address machine Email address of the sender/machine (this 
address also receives the email as Cc). 

Receiver address Email address of the receiver. Email 
addresses of several receivers are separated 
with a comma. 

Mail Server Mail server of your company or an external 
mail server. 

Use internal Mailing Set to True if the PC is connected to a local 
user profile and the company's mail server is 
used. 
If this value is set to False the values Port 
number, Use SSL and Password have to be 
entered. 
Note: At the moment, only the SMTP protocol 
is supported. Check if it is available via your 
provider. 

Port number Port number of the external mail server. Refer 
to the provider to ask for the port number. 

Use SSL Determines if the connection is encoded with 
SSL. 

Password Password of your mail provider. 
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2.1.16 Exit 
Exits and closes the current application. 

2.2 Menu Edit 
This menu contains functions to edit objects and their properties 

 
 

 

The icons/functions of the menu Edit are explained in the following table: 

Icon Name Description 

 
Undo 

The last action is undone. 

 
Redo 

Executes the last action once more that was performed 
by clicking on [Undo]. 

 
Repeat 

Executes the last action once more. 

 
Cut 

The selection is removed and added to the clipboard. 

 
Copy 

The selection is copied to the clipboard. 

 
Paste 

Pastes the contents from the clipboard to the cursor 
position. 

 
Delete 

The marked contents are deleted. 

 

2.2.1 Undo 
The last action is undone. 

Summary 

Click on [Undo] to undo the last action and to restore the previous state. 

The number of actions that can be undone can be set in the options. 

[Undo] can also be executed with the key combination (Ctrl) + (Z). 
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2.2.2 Repeat 
Executes the last action once more. 

Summary 

Click on [Repeat] to execute the previously performed action again. 

 [Repeat] can also be executed with the key combination (Ctrl) + (Y). 

2.2.3 Redo 
Executes the last action once more that was performed by clicking on [Undo]. 

Summary 

Click on [Redo] to execute the previously performed action again that was performed 
by clicking on [Undo]. 

 [Redo] can also be executed with the key combination (Ctrl) + (Y). 

2.2.4 Cut 
The selection is removed and added to the clipboard.  

Summary 

Click on [Cut] to remove the marked contents and to add them to the clipboard. These 
contents can be reinserted via [Paste]. 

 [Cut] can also be executed with the key combination (Ctrl) + (X). 

2.2.5 Copy 
The selection is copied to the clipboard. 

Summary 

Click on [Copy] to copy the marked contents to the clipboard. Use [Paste] to insert 
these contents to the cursor position. 

 [Copy] can also be executed with the key combination (Ctrl) + (C). 

2.2.6 Paste 
Pastes the contents from the clipboard to the cursor position. 

Summary 

Click on [Paste] to add contents from the clipboard to the cursor position. For 
example, these can be added to the clipboard via [Cut] or [Copy]. 

 [Paste] can also be executed with the key combination (Ctrl) + (V). 

2.2.7 Delete 
The marked contents are removed. 

Summary 

Click on [Delete] to remove the marked texts or objects (e.g. layers, toolpaths, etc.). 

Accidently removed contents can be restored with [Undo]. 

 [Delete] can also be executed with (Del). 
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2.3 Menu Insert 
This menu contains various objects that can be created in the CAM view. 

 
 

The entries of the menu Insert are described in the following table: 

Icon Name Description 

 
Flash 

Creates a flash based on the aperture currently selected. 

 
Path 

Creates a path in the current layer. 

 
Polygon 

Creates a polygon in the current layer. 

Rectangle or rectangle path… 

 
Rectangle 

Creates a filled rectangle in the current layer. 

 
Rectangle path 

Creates a rectangle path in the current layer. 

Circle or circle path… 

 
Circle by radius 

Creates a filled circle by defining a radius. 

 
Circle by points 

Creates a filled circle by setting three points. 

 
Circle path by radius 

Creates a circle path by defining a radius. 
 

 
Circle path by points 

Creates a circle path by setting three points. 

 
Text 

Creates a text object in the current layer. 

 Data Matrix Code Creates a Data Matrix Code in the current layer. 
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Icon Name Description 

Rubout area 

 Rubout all layers Creates a rubout area on all rubout layers. 

 <Create new layer> Creates a new layer Rubout. 

Fiducial 

 Fiducial 
 
<Create new layer> 

Creates a fiducial on the layer Fiducial 
 
Creates a new layer Fiducial. 

 

2.3.1 Flash 
Creates a flash based on the aperture currently selected. 

Summary 

Use the function [Flash] to create a flash on the basis of the apertures in the aperture 
library. If no aperture is selected the first aperture in the library is used. 

The flash is assigned to the currently selected layer. 

2.3.2 Path 
Creates a path in the current layer. 

Summary 

Use the function [Path] to create open and closed paths in the CAM view. These paths 
are automatically assigned to the currently selected layer and use the selected 
aperture or line. Only circular apertures can be used for paths. 

To close a path you have to create the last point and select [Close contour] in the 
context menu. To close the shape, the lines are automatically connected. 
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2.3.3 Polygon 
Creates a polygon in the current layer. 

Summary 

Use the function [Polygon] to create polygons in the CAM view. These polygons are 
automatically assigned to the currently selected layer. The individual lines can be 
created in straight lines or in arcs. After completing the element, the content is filled 
automatically. 

Open the context menu and click on [Finish] to close the polygon. 

 

2.3.4 Rectangle 
Creates a filled rectangle in the current layer. 

Summary 

Use the function [Rectangle] to create filled rectangles in the CAM view. The objects 
are automatically assigned to the currently selected layer. 

 
  



 

 

Menus 
 

CircuitPro 3.0 PL 

66/112  LPKF Laser & Electronics AG | V. 1.0 

2.3.5 Rectangle path 
Creates a rectangle path in the current layer. 

Summary 

Use the function [Rectangle path] to create rectangle paths in the CAM view. The 
objects are automatically assigned to the currently selected layer. 

 

2.3.6 Circle by radius 
Creates a filled circle by defining a radius. 

Summary 

Use the function [Circle by radius] to create circles in the CAM view. After the circles 
have been created, they are automatically filled and assigned to the currently selected 
layer. 
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2.3.7 Circle by points 
Creates a filled circle by setting three points. 

Summary 

Use the function [Circle by points] to create circles in the CAM view. After the circles 
have been created, they are automatically filled and assigned to the currently selected 
layer. 

 

2.3.8 Circle path by radius 
Creates a circle path by defining a radius. 

Summary 

Use the function [Circle path by radius] to create circle paths in the CAM view. After 
the circles paths have been created, they are automatically assigned to the active 
layer. 
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2.3.9 Circle path by points 
Creates a circle path by setting three points. 

Summary 

Use the function [Circle path by points] to create circle paths in the CAM view. After 
the circles paths have been created, they are automatically assigned to the currently 
selected layer. 

 

2.3.10 Text 
Creates a text in the current layer. 

Summary 

Use the function [Text] to create texts in the CAM view. The texts are automatically 
assigned to the currently selected layer. 
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2.3.11 Data Matrix Code 
Creates a Data Matrix Code in the current layer. 

Summary 

Use the function [Data Matrix Code] to create Data Matrix Codes (DMC) in the 
view CAM. The Data Matrix Codes are automatically assigned to the currently 
selected layer. 

 
 

2.3.12 Rubout all layers 
Creates a rubout area on all rubout layers. 

Summary 

Use the function [Rubout all layers] to create rubout areas in the CAM view. The areas 
are automatically created in all rubout layers. 

2.3.13 <Create new layer > 
Creates a new layer Rubout. 

Summary 

Use the function [<Create new layer>] to create an area in the CAM view. After the 
area has been created, it is automatically assigned to the new layer Rubout. 

2.3.14 Fiducial 
Creates a new fiducial. 

Summary 

Use the function [<Create new layer >] to create fiducials in the CAM view. 
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2.3.15 <Create new layer > 
Creates a fiducial on the layer Fiducial. 

Summary 

Use the function [<Create new layer >] to create fiducials in the CAM view. After the 
fiducial has been created, it is automatically assigned to the new layer Fiducial. 
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2.4 Menu Layout 
This menu contains functions for editing geometric objects in the CAM view. 

 
 

The entries of the menu Layout are described in the following table: 

Icon Name Description 

 Aperture list library Opens the dialog that displays all apertures used in the 
current project. 

 
Move Object 

Moves the marked object by a defined distance and 
direction. 

 
Rotate 

Rotates one or multiple objects by a definable pivot point. 

 
Mirror horizontal 

Mirrors one or multiple objects around the horizontal 
coordinate axis (x axis). 
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Icon Name Description 

 
Mirror vertical 

Mirrors one or multiple objects around the vertical axis of 
reflection (y axis). 

 
Scale 

Scales up or scales down the marked object by the scale 
factor. 

 
Expand 

Increases or decreases the marked object by a defined 
length. 

 
Round 

Rounds the corners of the marked object. 

 
Chamfer 

Chamfers the corners of the marked object. 

 
Split 

Splits the marked object by using a predefined path. 

 
Merge 

Merges adjoining or overlapping objects to a single 
geometrical object. 

 
Difference 

Removes the area of a geometrical object that is 
overlapped by a second selected object. 

 Change line width Changes the line width of the marked path. 

 
Add point 

Adds a point to a marked line. 

 
Add mirror point 

Adds two points with the same distance from the 
reference point. 

 
Move point 

Moves a marked point. 

 
Split path 

Splits the marked line segment of a path. 

 Set zero point Sets the zero point to the selected location in the CAM 
view. 

 
Convert to polygon 

Fills a marked closed path. 

 
Convert to closed path 

Removes the filling of filled objects. 

 
Group 

Groups marked objects. 

 
Ungroup 

Ungroups grouped objects. 

 
Measure 

Measures the distance starting from the selected position. 

 Reduce number of 
elements 

Reduce number of elements for open and closed paths 
and polygons. 

 
Close open path 

Closes an open path by connecting the end points. 



 
 

 

CircuitPro 3.0 PL 
 

Menus 

V. 1.0 | LPKF Laser & Electronics AG  73/112 

Icon Name Description 

 Design Rule Check Opens a dialog for setting the options of the Design Rule 
Check and for starting it. 

 Convert to flash Converts a marked object into a flash. 

 Combine to flash Combines two or more marked objects to one flash. 

 
Compare to flash 

Compares the marked flash with objects on the same 
layer. Objects of the same shape are converted into 
flashes. 

 Explode flash Converts the flash into an object. 
 

2.4.1 Aperture list library 
Opens the dialog Aperture list library. 

Summary 

In the dialog Aperture list library, aperture lists can be copied, edited, deleted and 
imported. 

 
 

2.4.2 Move object 
Moves the marked object by a defined distance and direction. 

Summary 

Before moving, a reference point has to be determined. This point can also be located 
outside of the marked object or even be created on other objects. After the reference 
point is defined, the distance and direction can be defined. 
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2.4.3 Rotate 
Rotates one or multiple objects around a definable pivot point. 

Summary 

The marked objects are rotated around one point. Thereby, you choose the position of 
the angle point and the rotation angle. 

 
 

2.4.4 Mirror horizontal 
Mirrors one or multiple objects around the horizontal coordinate axis (x axis). 

Summary 

The axis of reflection is located at the center of gravity of the selected object. If 
multiple objects are selected, a common center of gravity is calculated that is used for 
the reflection. The center of gravity can even be located outside of the objects. 

 

 

 
 

2.4.5 Mirror vertical 
Mirrors one or multiple objects around the vertical axis of reflection (y axis). 

Summary 

The axis of reflection is located at the center of gravity of the selected object. If 
multiple objects are selected, a common center of gravity is calculated that is used for 
the reflection. The center of gravity can even be located outside of the objects. 
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2.4.6 Scale 
Scales up or scales down the marked object by the scale factor. 

Summary 

All lines of the object are scaled uniformly so they keep their shape even after 
increasing/reducing the size. 

 
 

The function is only available if a single object is marked. Multiple objects cannot be 
scaled at the same time. 

2.4.7 Expand 
Increases or decreases the marked object by a definable length. 

Summary 

The marked object is increased or decreased uniformly around all sides. Increasing 
the object can cause a significant change of the shape. 

 
 

The function is only available if a single object is marked. Multiple objects cannot be 
expanded at the same time. 
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2.4.8 Round 
Rounds the corners of the marked object. 

Summary 

You can determine the radius of the rounding and select the angles to be rounded. 

There is a differentiation between the outer and the inner angles. 

 
 

Outer angles have an angle that is smaller than 180° within the geometrical object. 

 
 

Inner angles have an angle that is greater than 180° within the geometrical object. 
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2.4.9 Chamfer 
Chamfers the corners of the marked object. 

Summary 

You can determine the length of the sides to be chamfered and the angles to be 
chamfered. 

There is a differentiation between the outer and the inner angles. 

 
 

Outer angles have an angle that is smaller than 180° within the geometrical object. 

 
 

Inner angles have an angle that is greater than 180° within the geometrical object. 

 
 

2.4.10 Split 
Splits a marked object by using a predefined path. 

Summary 

When splitting, the first step is to draw a path across the object to be split. This path 
serves later as splitting line. After that, the object has to be marked and the function 
[Split] has to be activated. Mark the path to split the object at the position of that path. 
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2.4.11 Merge 
Merges adjoining or overlapping objects to a single geometrical object. 

Summary 

 [Merge] is only available if at least two geometrical objects are marked. 

Merged objects can only be restored to the previous state with [Undo]. 

 

 

 
The created object is assigned to the layer of the objects used. If the objects are 
located on different layers, the newly created object is assigned to the upmost layer 
used. 

2.4.12 Difference 
Removes the area of a geometrical object that is overlapped by a second selected 
object. 

Summary 

 [Difference] is only available if an object is marked. If the function is activated, a 
second object has to be selected. The area where the objects are overlapping is 
deleted. 

After using this function, the second object is deleted by default. This setting can be 
changed in the options. 

Objects that have been edited with [Difference] can only be restored to the previous 
state with [Undo]. 
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2.4.13 Change line width 
Changes the line width of the marked path. 

Summary 

 [Change line width] is only available if a path is marked. When increasing the line 
width, the outer corners are rounded. 

The line width is entered as a fixed value in mm. 

 
 

2.4.14 Add point 
Adds a point on a marked line segment. 

Summary 

 [Add point] is only available if a line or a point of a segment is marked. 
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2.4.15 Add mirror point 
Adds two points with the same distance from the reference point. 

Summary 

 [Add mirror point] is only available if a line or a point of a segment is marked. 

 
 

2.4.16 Move point 
Moves a marked point. 

Summary 

The marked point can be moved by using the mouse or by entering the relative 
coordinates. Multiple points can be marked as long as they are within the same object. 
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2.4.17 Split path 
Splits the marked line segment of a path. 

Summary 

The line segment can be split at the mouse position or by entering relative coordinates 
referring to the center of the path or the selected point. 

 
 

 [Split path] cannot be used for filled objects. 

2.4.18 Set zero point 
Sets the zero point to the selected position in the CAM view. 

 
 

2.4.19 Convert to polygon 
Fills a marked closed path. 

Summary 

 [Convert to polygon] is only available if a closed path is marked. 
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2.4.20 Convert to closed path 
Removes the filling of filled objects. 

Summary 

 [Convert to closed path] is only available for marked and filled objects. 

 
 

2.4.21 Group 
Groups marked objects. 

Summary 

 [Group] is only available if at least two objects are marked. 

 
 

2.4.22 Ungroup 
Ungroups grouped objects. 

Summary 

 [Ungroup] is only available if grouped objects are marked. 
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2.4.23 Measure 
Measures the distance, starting from the selected position. 

Summary 

The selected position is used as the initial point for measurement. As soon as you 
select another position, it is used as initial point for measurement. 

 
 

2.4.24 Reduce number of elements 
Removes redundant points in the marked object. 

Summary 

The shape of the object is not changed. Only the points that are not required for the 
current shape are removed. 

 
 

  



 

 

Menus 
 

CircuitPro 3.0 PL 

84/112  LPKF Laser & Electronics AG | V. 1.0 

2.4.25 Close open path 
Connects both end points of an open path with a line. 

Summary 

 [Close open path] is only available if an open path is marked. The marked object is 
converted to a closed path. 

 
 

2.4.26 Design rule check 
Opens the dialog Design rule check. 

Summary 

Use the Design rule check for checking if the PCB layout complies with the defined 
and recommended standards of the Design rule check. 

 
The following can be checked with the Design rule check: 

 Spacing of objects on different layers. 
 Spacing of objects on the same layer. 

  



 
 

 

CircuitPro 3.0 PL 
 

Menus 

V. 1.0 | LPKF Laser & Electronics AG  85/112 

2.4.27 Convert to flash 
Converts a marked object into a flash. 

 
 

2.4.28 Combine to flash 
Combines two or more marked objects to one flash. 

Summary 

Geometrical objects as well as flashes can be used. After combining the objects, an 
aperture based on the newly created flash is created. 

The combined objects within the flash can only be moved together. 

 
 

2.4.29 Compare to flash 
Compares the marked flash with objects on the same layer. Objects of the same 
shape are converted into a flash. 

Summary 

Smaller deviations of the object‘s size and angles can be adapted by entering 
tolerance values in the dialog. 
 

2.4.30 Explode flash  
Converts the flash into an object. 
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2.5 Menu Toolpaths 
This menu contains settings for toolpaths. 

 
 

The entries of the menu Toolpath are described in the following table:  

Icon Item Description 

 
Add laser insulate 

Opens a dialog with insulation methods. 

 
Add contour routing 

Opens a dialog with contour routing methods. 

 Add conversion Opens a dialog that enables you to create drill data and 
fiducials. 

 Edit breakout tabs Opens a dialog with setting options of the breakout tabs. 
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2.5.1 Add laser insulate 
Opens a dialog with insulation methods. 

Summary 

In the dialog Laser insulate, the insulation methods Basic, Basic, pads double, Partial 
rubout, and Complete rubout are available. 

Laser insulateThe dialog is structured as follows: 

 
 
Insulation method 

Basic 

Insulation with a single insulation channel. Shortest processing time. 

Basic, pads double 

Insulation with a single insulation channel. Double insulation channel for pads. Short 
process time. This method requires a bit more time than the first method Basic. 

Partial rubout 

Insulation with a single insulation channel. Removal of copper in defined areas. 

Complete rubout  

Entire removal of copper. Most precise insulation method. 

Insulation 

Function Description 

Source Indicates the layer where the insulation is 
created. 

Insulation width Indicates the insulation channel width in mm. 
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Function Description 

Pads insulation Indicates the width of the pad insulation in mm 
if an insulation method with additional pad 
insulation is selected. 

Target beam overlap Is calculated by the tool parameters. 

Actual beam overlap Is calculated from the insulation width and the 
tool parameter. 

Pads Is calculated from the pad insulation and the 
tool parameter. 

 

Rubout 

Function Description 

Rubout Indicates whether and on which layer the 
rubout is to be executed. Additionally, you can 
select how the rubout is to be executed. 

Hatching grid Indicates the distance between the two cutting 
toolpaths of the rubout. 

Minimum strip width If the distance between two PCBs is smaller 
than the minimum strip width, a rubout is not 
executed. Several laser toolpaths are added 
to remove the copper. 

Maximum strip length If a strip is longer than this value, the copper 
strip is divided by a cut. 

Maximum strip length in special areas Is valid for special areas (depends on the area 
size). If a strip is longer than this value, the 
copper strip is divided by a cut. 

Angle with Y axis The hatching grid is executed using this angle. 

Short/normal heat threshold If the heating strips are shorter than this value, 
the heating tool is switched automatically to 
the mode for short strips. 

Generate preCut curves Additional insulation lines are created to 
improve separation from the conductive track. 
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2.5.2 Add contour routing 
Opens a dialog with contour routing methods. 

Summary 

In the dialog Laser contour routing, the contour routing methods Basic, Horizontal 
gaps, Vertical gaps, Edge gaps, Corner gap and Equidistant gaps are available. 

Add contour routingThe dialog is structured as follows: 

 
 
Contour routing method 

Basic 

Contour routing without gaps. 

Horizontal gaps 

Contour routing with gaps on upper and lower edge. 

Vertical gaps 

Contour routing on left and right side. 

Edge gaps 

Contour routing with one gap on each edge. 

Corner gap 

Contour routing with one gap in each corner. 

Equidistant gaps 

Contour routing with equally spaced gaps. 

Contour routing 

Function Description 

Position inside The toolpath is inside the  
drawn BoardOutline 

Position outside The toolpath is outside the 
drawn BoardOutline 

Source Indicates the layer on which the contour is 
routed. 
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Function Description 

Channel width Indicates the insulation channel width in mm. 

Target beam overlap Indicates the overlapping of the beam in %. 

Actual beam overlap The value is calculated from the Target beam 
overlap and the tool parameter. 

Tabs position Indicates the position of the tabs. 

Gap width Indicates the width of the gaps. 

Distance Indicates the distance between the gaps in 
mm. 
This value is only provided for the method 
Equidistant gaps. 

 

2.5.3 Add conversion 
Opens a dialog that enables you to create drill data and fiducials. 

The dialog is structured as follows: 

 
 
 

Function Description 

Source Indicates the layer where the drill holes or the fiducials are to be 
created. 

Tool Indicates the tool the drill holes or the fiducials are to be created. 
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2.5.4 Edit breakout tabs 
Opens a dialog for editing the settings of the breakout tabs. 

Summary 

In the dialog Edit breakout tabs position the Gap width can be modified, the Break 
position can be changed by entering values for x and y , the breakout tabs can be 
deleted, and the breakout tabs can be created. 

The dialog is structured as follows: 

 
 
 

Function Description 

Gap width Width of the breakout tabs. 

Break position Position of the selected breakout tab. 

Replace existing toolpath Replaces existing toolpaths during calculation. 

Add breakout tab Adds a new breakout tab. 

Remove break Deletes the selected breakout tab. 

 

  

Ben Hurwitz
Breakout tabs
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2.6 Menu Processing 
This menu contains functions for processing the previously defined processing data. 

 
 

The entries of the menu Processing are described in the following table: 

Icon Item Description 

 
Material settings 

Opens a dialog for setting several parameters of the 
material to be processed. 

 
Tool library 

Opens a dialog for creating and editing tools. 

 Placement Opens a dialog for shifting the processing data. 

 Fiducial settings Opens a dialog with fiducial settings for the fiducial 
search. 

 
Alignment settings 

Opens a dialog for configuring the fiducial search. While 
processing, these settings are used for the fiducial 
search. 

 
Process all 

Starts the production of all processing data. 

 
Stop processing 

The current processing procedure is stopped. 

 Connect to machine Opens a dialog for connecting the system software to a 
real or simulated machine. 

 

2.6.1 Material settings 
Opens a dialog for setting several parameters of the material to be processed. 

Summary 

In the dialog Material settings the Machine type and the Material type can be selected, 
the Material thickness can be entered and custom material can be created. 
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2.6.2 Tool library 
Opens a dialog for creating and editing tools. 

Summary 

The available LPKF tools and their detailed information are accessible in the dialog 
Tool library  The LPKF tools cannot be edited. New tools can be created and edited. 
The newly created tools can be assigned to several tasks and their parameters can be 
defined. The parameters are divided into the following groups: Main, Laser 
parameters, Scanner parameters, Type of circle, Start/End moves, Process 
parameters, Polygon moves, and Hatching parameters 

The dialog is structured as follows: 

 
 

 

Item Description 

Main 

Enabled Makes the task available/unavailable for the 
production process. 

Laser parameters 

Frequency [kHz] Sets the pulse frequency of the laser. 

Power [W] Sets the power of the laser. 

z offset tool [µm] z offset of the tool. 

Scanner parameters 

Jump delay [µs] Defines the delay before a jump. 
(A jump is the move between two toolpaths where 
the laser is not structuring). 

Jump speed [mm/s] Sets the speed of the jump move. 

Laser on delay [µs] Delay of the laser source when starting 
structuring. 

Laser off delay [µs] Delay of the laser source when stopping 
structuring. 

Mark delay [µs] Delay of the scanner before and after structuring. 

Mark speed [mm/s] Sets the speed of the movement of the 

Ben Hurwitz
Tool library
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Item Description 

structuring. 

Polygon delay [µs] Delay of the laser source between the individual 
points of a polygon. 

Type of circle 

Beam diameter [µm] This value sets the toolpath spacing. The laser 
beam diameter can vary due to material 
properties, power, and frequency. It is 
recommended to execute and measure a single 
test cut. 

Drill overlap [µm] Overlap used for radius calculation for filling 
strategies. 

Circle inner diameter [µm] With the circle type Concentric fill, the circle is not 
completely removed. The circle inner diameter 
indicates the area in the center that is not 
removed. 

Circle type Indicates the filling strategy of how to remove the 
inside of a drill hole. 
Outer circle: A line along the circle 
Concentric fill: The drilling is executed by 
concentric circles. 
Spiral: The drilling is executed by a spiral. 
From file: For future features. 

Number of runs Indicates the number of runs that are drilled. 

Outward True 
The processing is started from the inside to the 
outside. 
False 
The processing is started from the outside to the 
inside. 

Start/End moves 

Start moves Enables start moves. 

Start move length [µm] Length of the start move. 

Start move type Type of move for start moves (with or without 
activated laser). 

End moves Enables end moves. 

End move length [µm] Length of the end move. 

End move type Type of move for end moves (with or without 
activated laser). 

Process parameters 

Air pressure Enables air pressure 

Processing mode Determines whether the defocused mode (rubout) 
or focused mode (normal mode) is used. 

Tool Z-Offset Offset for this tool in z direction. In contrast to the 
parameter Z-Offset the calibration table is not 
switched. 

Tool delay [ms] Delay when switching between Tools/Tasks. 

Repetition Number of repetitions of a toolpath. 

Polygon moves 
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Item Description 

Polygon moves Enable moves on intermediate polygon points. 

Start move length [µm] Type of move for start moves (with or without 
activated laser). 

End move length [µm] Type of move for end moves (with or without 
activated laser). 

Start move type Type of move for start moves (with or without 
activated laser). 

End move type Type of move for end moves (with or without 
activated laser). 

Enable min angle Enable/Disable use of minimal angle for sky 
writing. 

Min angle Minimum angle for sky writing. 

Hatching parameters 

Stretch and shrink [%] Used for correction and reduction of lines. It is 
measured in percents of the hatching overlap. 

Hatch overlap [%] It is measured in percents of the effective beam 
diameter. This value is used for computing 
toolpaths. 

Beam compensation [µm] Used for computing toolpaths near shape 
boundaries. 

Triangle max size [mm] Maximum size of triangle, used to triangulate 
surfaces for toolpath generation. 

 

 Copying tools  

1. Click on Production > Tool library.... 
 The following dialog is displayed:  

 
 
2. Select a tool you want to copy. 

The values of the selected tool are adopted while copying. 
3. Click on [Add tool...]. 
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 The following dialog is displayed:  

 
 
4. Enter the name of the new tool. 
5. Click on [OK]. 
 The new tool has been added. 

 The tool has been copied. 

 Editing tool parameters 

1. Click on Production > Tool library.... 
 The following dialog is displayed:  

 
 
2. Select a newly created tool you want to edit. 
3. Adjust the tool parameters as required.  
4. Click on [OK]. 

 The tool parameters have been edited.  
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 Adding a task 

1. Click on Production > Tool library.... 
 The following dialog is displayed: 

 
 
2. Select a newly created tool. 

The task is added to this tool. 
3. Click on . 
 A new task (Task 2) is added to the tool. 
4. Adjust the tool parameters as required. 
5. Click on [OK]. 

 The task has been added. 

2.6.3 Placement 
Opens a dialog for shifting the processing data. 

Summary 

The dialog Placement enables you to shift the processing data by entering the values 
x and y. You can move the data via drag & drop. 

The button Specify center point positions the processing data to the center of the 
processing area. 
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2.6.4 Fiducial settings 
Opens a dialog for configuring the fiducial recognition for the manual fiducial search. 

Summary 

The dialog Fiducial settings enables you to configure the search area and to set the 
fiducial criteria.  

The dialog is structured as follows: 

 
 

 

Name Description 

ROI configuration 

Width Within this pixel width the fiducial is searched. A 
small value increases the search speed. If the 
value is to small, the object is not recognized if it 
is located outside the search area. 

Height Within this pixel height the fiducial is searched. A 
small value increases the search speed. If the 
value is to small, the object is not recognized if it 
is located outside the search area. 

Offset x Indicates the distance of the search area to the 
left edge of the camera image. 

Offset y Indicates the distance of the search area to the 
upper edge of the camera image. 

Fiducial criteria 

Diameter Expected diameter of the object to be measured. 

Tolerance Allowed deviation of the diameter. 

Minimum quality Is the value that indicates the deviation between 
the camera image and the optimum image. If the 
values are too high only few fiducials are 
recognized. If the values are too small wrong 
objects are recognized. The optimum default 
value is 90%. 

Maximum form factor The maximum form factor is a calculation 
parameter within the fiducial recognition. This 
value can be changed for faster teaching. The 
default value is 10. 
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2.6.5 Alignment settings 
Opens a dialog for configuring the fiducial search. 

Summary 

In the dialog Alignment settings you can configure the fiducial search settings. While 
processing, these settings are used for the fiducial search. 

The dialog is structured as follows: 

 
 

 

Name Description 

Manual confirmation of fiducials If this function is activated, the position has to be 
manually confirmed, after a fiducial is found. 

Always center fiducials for detection If this function is activated, the camera is 
positioned above the center of the fiducial. 

ROI width This number of pixels is used for the search in the 
camera pane. If this value is decreased, teaching 
works faster. But large fiducials (larger than 
1 mm) incur the risk of not being recognized. 

ROI height This number of pixels is used for the search in the 
camera pane. If this value is decreased, teaching 
works faster. But large fiducials (larger than 
1 mm) incur the risk of not being recognized. 

Minimum fiducial quality The smaller this value, the less accurate the 
fiducial can be and still be recognized. The default 
value is 90% and should not set below 80%. 

 

2.6.6 Process all 
Starts the production of all processing data. 

2.6.7 Stop processing 
The current processing procedure is stopped. 

2.6.8 Connect to machine 
Opens a dialog for connecting the system software to a real or simulated machine. 

Summary 

Select an appropriate machine for connection from the drop-down list. 

You can also simulate a virtual machine without connecting to a real machine. 
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2.7 Menu Service 
This menu contains password-protected menu items that are only available for the 
LPKF Service. 

Use the menu item Send support information to send an email with support 
information to the LPKF Service. 

 
 

The entries of the menu Service are described in the following table:  

Icon Item Description 

 Camera Only accessible for the LPKF Service. 

 Laser Only accessible for the LPKF Service. 

 Motion system Only accessible for the LPKF Service. 

 Scanner Only accessible for the LPKF Service. 

 TrAF calibration Only accessible for the LPKF Service. 

 xCont settings Only accessible for the LPKF Service. 

 Import settings Only accessible for the LPKF Service. 

 Send support information Sends an email with support information to the LPKF 
Service. 

 

2.7.1 Send support information 
Sends support information to the LPKF Service 
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3 How to work with the software 

3.1 Typical production process 
This chapter describes a typical production process. The following steps are 
performed: 

 Switching on the system 

1. Press the on/off switch at the system front. 
 The system is switched on. The PC boots automatically. 
2. Double-click on the desktop icon of CircuitPro PL 3.0. 

 
 

 The user interface of CircuitPro PL is displayed: 

 
 

 The system software recognizes the connected system automatically, establishes 
the connection and the following message is displayed: 

 
 

 The following dialog is displayed:  

 
 

3. If all lamps of the stack light are lit, click on [Yes]. 
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 The following dialog is displayed: 

 
 

4. Select the template PLU4_doublesided_NoTHP.cp2d. 
5. Click on [Load template]. 
 The following dialog is displayed: 

 
 

6. Select the Machine type and the Material type. 
7. Enter the Material thickness. 
8. Click on [OK]. 

 The system has been switched on. 

  

 

Connecting the system manually 

If automatic connection of the system fails, you can connect the system manually 
with the system software: 
 Click on Production > Connect with machine… 
 Select your system in the drop-down list. 
 Click on [Connect]. 
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The system requires a warm-up time of approx. 20 minutes for the laser source to 
attain a constant diode temperature. The warm-up phase starts automatically with 
the processing of the first job. 
Alternatively, you can start the warm-up phase manually. In the Processing view, 
click on . You can continue working in the CAM view during the warm-up phase. 

  
 

 Importing the data 

1. Click on File> Import or on . 
 The following dialog is displayed: 

 
 

2. Navigate to the folder C:\Users\User name\Documents\LPKF Laser & 
Electronics\LPKF CircuitPro PL 3.0\Example 

Data\UseCase_DoubleSidedPCB and select the files Tutor.BOA, Tutor.BOT, 
Tutor.DRL and Tutor.TOP. 

3. Click on [Open]. 



 

 

How to work with the software 
 

CircuitPro 3.0 PL 

104/112  LPKF Laser & Electronics AG | V. 1.0 

 The data are automatically assigned to the correct layers and the following dialog 
is displayed: 

 
 

4. In the column Layer/Template select the layer DrillPlated. 
5. Click on [OK]. 
 The CAM view changes as follows: 

 
 

 The data have been imported. 

 Inserting fiducials 

1. Click on Insert > Fiducial > Fiducial. 
2. Insert four fiducials. 
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3. Press (ESC). 
 The function is closed. 

 The fiducials have been inserted. 

 Computing toolpaths and scan fields automatically 

1. In the pane Workflow setup right-click on the section Toolpaths. 
 The following context menu is displayed: 

 
 

2. Click on the menu item Compute all… 
 The scan fields and toolpaths are computed automatically with default settings and 

the following message is displayed: 

 
 

3. Click on [Close]. 

 The toolpaths have been computed. 
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If you do not want to compute the toolpaths and scan fields with the default settings, 
you can adapt the settings to your needs (see Configuring toolpaths manually and 
Computing scan fields manually).  

 Configuring toolpaths manually 

1. In the pane Workflow setup right-click in the Toolpaths section on Fiducials. 
 The following context menu is displayed: 

 
 

2. Click on the menu item Configure… 
 The following dialog is displayed: 

 
 

3. Adapt the settings if necessary. 
4. Click on [Save]. 
5. In the pane Workflow setup right-click in the Toolpaths section on Top Layer. 
 The context menu is displayed. 
6. Click on the menu item Configure… 
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 The following dialog is displayed: 

 
 

7. Adapt the settings if necessary. 
8. Click on [Save]. 
9. In the pane Workflow setup right-click in the Toolpaths section on Bottom Layer. 
 The context menu is displayed. 
10. Click on the menu item Configure… 
 The dialog Laser insulate is displayed. 
11. Adapt the settings if necessary. 
12. Click on [Save]. 
13. In the pane Workflow setup right-click in the Toolpaths section on Drill Plated. 
 The context menu is displayed. 
14. Click on the menu item Configure… 
 The following dialog is displayed: 

 
 

15. Adapt the settings if necessary. 
16. Click on [Save]. 
17. In the pane Workflow setup right-click in the Toolpaths section on Drill Unplated. 

The toolpath Drill Unplated is not used for this PCB and can be deleted. 
 The context menu is displayed. 
18. Click on the menu item Delete. 
 The unused toolpath Drill Unplated is deleted. 
19. In the pane Workflow setup right-click in the Toolpaths section on Contour. 
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 The context menu is displayed. 
20. Click on the menu item Configure… 
 The following dialog is displayed: 

 
 

21. Adapt the settings, if necessary. 
22. Click on [Save]. 

 The toolpaths have been configured. 

 Computing scan fields manually 

1. In the pane Workflow setup right-click in the Production section on Bottom Side 
(Standard). 

 The following context menu is displayed: 

 
 

2. Click on the menu item Compute scan fields. 
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 The following dialog is displayed: 

 
 

3. Adapt the settings, if necessary. 
4. Click on [OK]. 
 The CAM view changes as follows: 

 
 

2. In the pane Workflow setup right-click in the Production section on Top Side 
(Standard). 

 The following context menu is displayed: 

 
 

5. Click on the menu item Compute scan fields. 
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 The following dialog is displayed: 

 
 

6. Adapt the settings, if necessary. 
7. Click on [OK]. 
 The CAM view changes as follows: 

 
 

 The scan fields have been computed. 

 Processing a PCB 

1. Measure the thickness of the material with a calliper gauge. 

 

Clean the material surface with a micro etchant (e.g. ViaCleaner) if a discoloration 
(oxide layer) is discernible. Thus, a surface is achieved that always has the same 
characteristics. 
2. Click on Processing > Process all or in the Production view on . 
 The following messages are displayed:  
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3. Open the cover. 
4. Place the base material onto the x/y table. 
5. In the Production view, click on . 
 The base material is affixed to the x/y table. 
6. Close the cover. 
7. Click on [OK]. 
 The following dialog is displayed:  

 
 

8. Enter the measured value in the field Material thickness. 
9. Click on [Continue]. 
 The following dialog is displayed: 

 
 

10. Place the processing data. 
The production data can be moved using drag & drop or by entering the values in 
the fields x an y. Click on [Set center] to place the processing data at the center of 
the base material. 

11. Click on [Continue]. 
 The structuring is started and the following message is displayed:  

 
 

12. Turn the base material over around the symmetry axis of the system. 
13. Fasten the material along its edges with adhesive tape. 
14. Click on [OK]. 
15. If the fiducials are not found automatically, the following message is displayed: 
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16. Switch to the Camera view. 
17. Move the camera image to the position of the fiducial and click on [Confirm]. 
 The structuring is started and the following message is displayed:  

 
 

 The PCB has been processed.  

 Stopping processing 

1. Click on Processing > Stop processing. 
Alternatively, click on . 

 Processing has been stopped. 

 Switching off the system 

1. Click on File > Exit. 
 The connection to the system is disconnected and the system software is closed. 
2. Perform one of the following steps: 

 In the Windows user interface, click on Start > Shut down. 
 Press the On/Off button at the system front briefly. 

 The operating system is shut down. 

 The system has been switched off. 

 Cleaning the system 

The processing area has to be cleaned if heavily soiled. 

 Use a vacuum cleaner to remove chips and residues from the processing area. 
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